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Introduction
These are the release notes for Release 4.1.1 of the ST integrated development 
environment, which is now called ST Visual Develop and abbreviated to STVD. The name 
change from STVD7 to STVD reflects the extension of the development environment to 
support the new STM8 microcontroller families. These release notes are updated 
periodically in order to keep you abreast of evolutions of the software and any problems or 
limitations found in this release. Check the ST microcontroller support website at 
www.st.com to ensure that this is the latest version of these release notes.

Changes in the release notes for STVD 4.1.1

Customer support
For more information or help concerning STVD, please contact the nearest sales office. For 
a complete list of ST offices and distributors, please refer to www.st.com.

Software updates

You can download software updates and all the latest documentation from the ST 
microcontroller support site at www.st.com.

New features Support of new STM8 microcontrollers by STICE, ICD-SWIM and STM8 simulator:
• STM8S family: 8 K and  32 K Flash
• STM8L family: 8 K Flash

Improvements • STM8 data EEPROM is now writeable (as a RAM) by the application on STICE.

Corrections • Bugfix unexpected NEM breaks on STICE (RETF, IRET when crossing a 64 Kbyte 
boundary).
• Bugfix wrong location in disassembly window on STM8 when stopping on code 
deprived of debug information.
• Correction of bad option description for ST7FL3x microcontrollers on ST7-ICD-
ICC target.

www.st.com

http://www.st.com
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1 Read me first

This section provides important information about STVD Release 4.1.1.

1.1 Host PC system requirements
PC and compatibles running with Windows 2000, Windows XP, and Vista® operating 
systems.

Note: 1 Administrator privileges are required to install STVD and to connect emulators to the USB 
port for the first time. Power user or administrator privileges are required to run STVD.

2 Under the Vista operating system, you must run STVD as administrator. You can either turn 
off the User Account Control feature (not recommended), or use the Run as Administrator 
command from the contextual menu, then Allow execution.

1.2 Emulation hardware support
This version includes the ST7 simulator (no emulation hardware required) and supports 
certain ST7-EMU2 (HDS2) emulators with active probes, all generations of ST7-DVPx 
emulators, ST7-EMU3 series emulators and in-circuit debugging with the ST7-EMU3 with 
ICC Add-on, the ST7-DVP3 series emulators, the Raisonance RLink, ST7-STICK, and the 
STICE advanced emulation system.

Listings of supported ST7 and STM8 devices for each STVD debugging target (emulators, 
ICD and Simulator) are provided in Section 2.2 on page 6.

1.3 About using the Cosmic C toolset
STVD Release 4.1.1 was validated using the Cosmic C toolset versions 4.5.7 for ST7, and 
4.2.7 for STM8. In order to use the Cosmic C toolset with STVD, the cvdwarf.exe Cosmic 
convertor is needed to generate the “.elf” debug information files required by STVD. The 
cvdwarf.exe Cosmic converter is included in the Cosmic C toolset versions 4.2a and 
later. You can download this or a later version from: www.cosmic-software.com.

1.4 About using the Metrowerks C toolset
STVD Release 4.1.1 was validated with the C toolset installed with Metrowerks v 1.1. The 
industry standard ELF/Dwarf format is the default output format for the Metrowerks C 
toolset. When building, the -f2 option for the C compiler and the lib.e20 library are 
chosen by default.

For reasons of legacy compatibility, the Metrowerks C toolset and STVD continue to support 
the proprietary Hiware format. However, Hiware format users must use a script link file in the 
Project Settings interface when building their applications.

Note: Any references to “Metrowerks” and “Hiware” in STVD software, examples and 
documentation refer to the Metrowerks C toolset.
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1.5 About using the Raisonance C toolset
STVD Release 4.1.1 was validated using version 2.13 of the Raisonance C toolset. In order 
to use the Raisonance C toolset with STVD, the omf2elf.exe Raisonance convertor is 
needed to generate the .elf debug information files required by STVD. The omf2elf.exe 
Raisonance converter is included in the Raisonance C toolset.

2 What’s new in STVD Release 4.1.1?

2.1 Summary of changes in Release 4.1.1

New features

New features in this release include:

● Support of new STM8 microcontrollers by STICE, ICD-SWIM and STM8 simulator:

– STM8S family: 8 K and  32 K Flash.

– STM8L family: 8 K Flash.

Improvements

Improvements in this release include:

● STM8 data EEPROM is now writeable (as a RAM) by the application on STICE.

Corrections

Corrections in this release include:

● Bugfix unexpected NEM breaks on STICE (RETF, IRET when crossing a 64 Kbyte 
boundary).

● Bugfix wrong location in disassembly window on STM8 when stopping on code 
deprived of debug information.

● Correction of bad option description for ST7FL3x microcontrollers on ST7-ICD-ICC 
target.

2.2 Hardware and targets supported by this release
The ‘F’ notation in MCU names denoting ‘Flash’ variants is only indicated for ICD. Debug 
instruments support emulation/simulation of Flash variants of the listed MCUs, unless 
otherwise indicated.
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STICE advanced emulation system

List of supported devices for emulation with STICE:

ST7-EMU3 emulators

List of supported devices by emulator:

STM8A(F/H)STM8A(F/H)5169, STM8A(F/H)5178, 
STM8A(F/H)5179, STM8A(F/H)5188, 
STM8A(F/H)5189, STM8A(F/H)5198, 
STM8A(F/H)5199, STM8A(F/H)519A, 
STM8A(F/H)51A8, STM8A(F/H)51A9, 
STM8A(F/H)51AA

STM8A(F/H)6146, STM8A(F/H)6148, 
STM8A(F/H)6166, STM8A(F/H)6168, 
STM8A(F/H)6169, STM8A(F/H)6176, 
STM8A(F/H)6178, STM8A(F/H)6179, 
STM8A(F/H)6186, STM8A(F/H)6188, 
STM8A(F/H)6189,STM8A(F/H)6198, 
STM8A(F/H)6199, STM8A(F/H)619A, 

STM8A(F/H)61A8, STM8A(F/H)61A9, 
STM8A(F/H)61AA

STM8L101F2(P/U), STM8L101F3(P/U), 
STM8L101G2, STM8L101G3, STM8L101K3

STM8S103F3, STM8S103K3, STM8S105C4, 
STM8S105C6, STM8S105K4, STM8S105K6, 
STM8S105S4, STM8S105S6
STM8S208MB, STM8S208RB, STM8S207MB, 
STM8S207RB, STM8S207CB, STM8S207R8, 
STM8S207C8, STM8S207S8, STM8S207R6, 
STM8S207K6

STM8S903K3

ST7MDT10-EMU3 ST72260G1, ST72262G(1/2), ST72264G(1/2), ST7DALI, ST7LCD1, 
ST7LIT10BF(0/1), ST7LIT15BF(0/1), ST7LIT19BF(0/1), ST7LIT10BY(0/1), 
ST7LIT15BY(0/1), ST7LIT19BY(0/1), ST7LITE(02/05/09/10/15/19/20/25/29/ 
30/35/39), ST7LITES(2/5), ST7LITEUS(2/5), ST7FLITEU0(2/5/9), 
ST7L(05/09/15/19/34/35/38/39)

ST7MDT20J-EMU3 ST72321BJ(6/7/9), ST72321J(7/9), ST72321BK6, ST72324BJ(2/4/6), 
ST72324BK(2/4/6), ST72324BLJ(2/4/6), ST72324BLK(2/4/6), 
ST72324J(2/4/6), ST72324K(2/4/6), ST72324LJ(2/4/6), ST72324LK(4/6), 
ST72325C(4/6), ST72325J(4/6/7/9), ST72325K(4/6), ST7232AJ(1/2), 
ST7232AK(1/2)

ST7MDT20M-EMU3 ST72321AR(6/7/9), ST72321BAR(6/7/9), ST72321BR(6/7/9), 
ST72321R(6/7/9), ST72325AR(6/7/9), ST72325R(6/7/9), ST72521AR(6/9), 
ST72521BAR(6/9), ST72521BR(6/9), ST72521BM9, ST72521M9, 
ST72521R(6/9)

ST7MDT50-EMU3 ST7MC1K(2/4/6), ST7MC2(N6/M9/R6/R7/S4/S6), ST7MC2S7

ST7MDT40-EMU3
(ST7MIDI-EMU3)

ST72340K(2/4), ST72340S(2/4), ST72344K(2/4), ST72344JS2/4), ST72345C4

ST7DVD3-EMU3 DVD3, L6315_10_RAM, L6315_10_ROM

ST7MDTH1-EMU3 ST7XGAM(J4T1/K4M1), ST7XGAM(J6T1/K6M1), ST7HUBAR4T1, 
ST7HUBAR6T1

ST7MDTU3-EMU3 ST7260E(1/2), ST7260K(1/2), ST7263BE(1/2/4/6), ST7263BH(2/6), 
ST7263BK(1/2/4/6)

ST7MDTU7-EMU3 ST7267

ST7FLCD-EMU3 ST7LCD1



What’s new in STVD Release 4.1.1? RN0013

8/29  

ST7-DVP3 emulators

List of supported devices by emulator:

ST7-ICD-ICC

List of supported devices for in-circuit debugging. Applications can be in-circuit debugged on 
the microcontrollers listed below from STVD using any of the following development tools:

● ST7MDT10-DVP3, ST7MDT20-DVP3, ST7MDT25-DVP3 series emulators: they are 
all are accessed from STVD as ICD (ST Micro Connect or DVP3)

● ST7-EMU3 series emulators – ST Micro Connect with ICC add-on. They are all are 
accessed from STVD as ICD (ST Micro Connect or DVP3).

● RLink from Raisonance (accessed from STVD as ICD RLink)

● ST7-STICK (accessed from STVD as ICD Stick):

ST7MDT10-DVP3 ST72260G1, ST72262(G1/G2), ST72264(G1/G2), ST7DALI, 
ST7LIT10BF(0/1), ST7LIT15BF(0/1), ST7LIT19BF(0/1), ST7LIT10BY(0/1), 
ST7LIT15BY(0/1), ST7LIT19BY(0/1), ST7LITE(02/05/09/10/15/19/20/25/29/ 
30/35/39), ST7LITES(2/5), ST7LITEUS(2/5), ST7L(05/09/15/19/34/35/38/39)

ST7MDT20-DVP3 ST72321AR(6/7/9), ST72321BAR(6/7/9), ST72321BJ(6/7/9), ST72321BK6, 
ST72321BR(6/7/9), ST72321J(7/9), ST72321M(6/9), ST72321R(6/7/9), 
ST72324BJ(2/4/6), ST72324BK(2/4/6), ST72324BLJ(2/4), ST72324BLK(2/4), 
ST72324J(2/4/6), ST72324K(2/4/6), ST72324LJ(2/4/6), ST72324LK(2/4/6), 
ST72325AR(6/7/9), ST72325C(4/6), ST72325J(4/6/7/9), ST72325K(4/6), 
ST72325R(6/7/9), ST72521AR(6/9), ST72521BAR(6/9), ST72521BM9, 
ST72521BR(6/9), ST72521M9, ST72521R(6/9), ST7232AJ(1/2), 
ST7232AK(1/2)

ST7MDT25-DVP3 ST72361AR(4/6/7/9), ST72361J(4/6/7/9), ST72361K(4/6/7/9), 
ST72361R(4/6/7/9), ST72561AR(4/6/7/9), ST72561J(4/6/7/9), 
ST72561K(4/6/7/9), ST72561R(4/6/7/9)

ST72260G1, ST72262(G1/G2), ST72264(G1/G2), 
ST7267

ST7FDALI, ST7FLCD1
ST7FLIT10BF(0/1), ST7FLIT15BF(0/1), 
ST7FLIT19BF(0/1), ST7FLIT10BY(0/1), 
ST7FLIT15BY(0/1), ST7FLIT19BY(0/1)

ST7FLITE0(2/5/9), ST7FLITE1(0/5/9), 
ST7FLITE2(0/5/9), ST7FLITE3(0/5/9), 
ST7FLITES(2/5), ST7FLITEUS(2/5), 
ST7FLITEUSICD, ST7FLITEU0ICD
ST7FL1(5/9), ST7FL3(4/5/8/9)

ST7WIND11, ST7WIND21

ST7FMC1K(2/4/6), ST7FMC2(M9/N6/R6/
R7/R9/S4/S6/S7/S9), ST7FMC2R9, ST7FMC2S9 

ST72F321BAR(6/7/9), ST72F321BJ(6/7/9), 
ST72F321BK6, ST72F321BR(6/7/9), 
ST72F325AR(6/7/9), ST72F325C(4/6), 
ST72F325J(4/6/7/9), ST72F325K(4/6), 
ST72F325R(6/7/9), ST72F325S(4/6)

ST72F340(K2/K4/S2/S4), 
ST72F344(K2/K4/S2/S4),

ST72F345C4

ST7FLITE49M
ST7FOXK1, ST7FOXK2, ST7FOXF1, 
ST7FLITE49K2T6, ST7FLITE49K2B6
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STM8-ICD-SWIM

List of supported devices for in-circuit debugging from STVD with ST-Link, RLink, or STICE:

ST7-EMU2 (HDS2) emulators

List of supported devices by emulator:

STM8A(F/H)5169, STM8A(F/H)5178, 
STM8A(F/H)5179, STM8A(F/H)5188, 
STM8A(F/H)5189, STM8A(F/H)5198, 
STM8A(F/H)5199, STM8A(F/H)519A, 
STM8A(F/H)51A8, STM8A(F/H)51A9, 
STM8A(F/H)51AA

STM8A(F/H)6146, STM8A(F/H)6148, 
STM8A(F/H)6166, STM8A(F/H)6168, 
STM8A(F/H)6169, STM8A(F/H)6176, 
STM8A(F/H)6178, STM8A(F/H)6179, 
STM8A(F/H)6186, STM8A(F/H)6188, 
STM8A(F/H)6189, STM8A(F/H)6198, 
STM8A(F/H)6199, STM8A(F/H)619A, 

STM8A(F/H)61A8, STM8A(F/H)61A9, 
STM8A(F/H)61AA
STM8L101F2(P/U), STM8L101F3(P/U), 
STM8L101G2, STM8L101G3, STM8L101K3
STM8S103F2, STM8S103F3, STM8S103K3

STM8S105C4, STM8S105C6, STM8S105K4, 
STM8S105K6, STM8S105S4, STM8S105S6

STM8S207MB, STM8S207RB, STM8S207CB, 
STM8S207R8, STM8S207C8, STM8S207S8, 
STM8S207R6, STM8S207K6, STM8S208MB, 
STM8S208RB

STM8S903K3

ST7MDT00-EMU2B ST7LITE0(5/9)

ST7MDT1-EMU2B ST72104G(1/2), ST72215G2, ST72216G1, ST72254G(1/2)

ST7MDT2-EMU2A ST72124J2, ST72311R(6/7/9)

ST7MDT2-EMU2B
ST72314J(2/4), ST72314N(2/4), ST72334J(2/4), ST72334N(2/4), 
ST72511R(6/7/9) ST72512R4, ST72532R4 

ST7MDT5-EMU2B ST72141

ST7MDT6-EMU2B ST72171K2(B/M)6

ST7MDT7-EMU2B ST72C411R1

ST7MDTS1-EMU2B ST7SCR1(E/R)

ST7MDTU2-EMU2B
ST72611F1, ST72P611F4, ST72621J(2/4), ST72621K4, ST72621L4, 
ST72622(K/L)2, ST72623F2

ST7MDTU3-EMU2B ST7263BK(1/2), ST7263BK4

ST7MDTU5-EMU2B ST72651, ST72652

ST7263-EMU2B ST72631, ST72632, ST72633

ST72774-EMU2B ST72734J6, ST72754J(6/9), ST72774J(6/7/9)

ST7MDT1-EMU2 ST72101G(1/2), ST72212G2, ST72213G1, ST72251G(1/2)

ST7255B-EMU2 ST7255B

ST7285-EMU2 ST7285

ST7291-EMU2 ST7291L(2/3/4/5/5A/6)

ST72589B-EMU2 ST72389(B/C), ST72589(B/C)
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ST7-DVP/DVP2 emulators (first and second generation)

Simulators

ST7MDT1-DVP ST72101G(1/2), ST72212G2, ST72213G1, ST72251G(1/2)

ST7MDT1-DVP2 ST72101G(1/2), ST72104G(1/2), ST72212G2, ST72213G1, ST72215G2, 
ST72216G1, ST72251G(1/2), ST72254G(1/2)

ST7MDT2-DVP ST72121J(2/4), ST72311J(2/4), ST72311N(2/4), ST72331J(2/4), ST72331N(2/4)

ST7MDT2-DVP2 ST72124J2, ST72311R(6/7/9), ST72314J(2/4), ST72314N(2/4), ST72334J(2/4), 
ST72334N(2/4), ST72511R(6/7/9), ST72512R4, ST72532R4

ST7MDP-DVP2 ST7MDP

ST7 BASELINE ST72101G(1/2), ST72104G(1/2), ST72121J(2/4), ST72124J2, ST72212G2, 
ST72213G1, ST72215G2, ST72216G1, ST72251G(1/2), ST72254G(1/2), 
ST72311J(2/4), ST72311N(2/4), ST72311R(6/7/9), ST72314J(2/4), 
ST72314N(2/4), ST72331J(2/4), ST72331N(2/4), ST72334J(2/4), ST72334N(2/4)

ST7 LITE ST72260G1, ST72262G(1/2), ST72264G(1/2), ST7DALI, ST7LIT10BF(0/1), 
ST7LIT15BF(0/1), ST7LIT19BF(0/1), ST7LIT10BY(0/1), ST7LIT15BY(0/1), 
ST7LIT19BY(0/1), ST7LITE(02/05/09/10/15/19/20/25/29/30/35/39), ST7LITES(2/5), 
ST7L(05/09/35/39), ST7FLITEU0(2/5/9), ST7FLITE49M, ST7FOXK1, ST7FOXK2, 
ST7FOXF1, ST7FOXA0, ST7FLUS5, ST7FLU05, ST7FLU09, ST7FLI49K2T6, 
ST7FLI49K2B6

ST7 MID-RANGE ST7232AJ(1/2), ST7232AK(1/2), ST72321AR(6/9), ST72321BAR(6/7/9), 
ST72321BJ(6/7/9), ST72321BK6, ST72321BR(6/7/9), ST72321J(7/9), 
ST72321M(6/9), ST72321BM(6/9), ST72321R(6/7/9), ST72324BJ(2/4/6), 
ST72324BK(2/4/6), ST72324BLJ(2/4), ST72324BLK(2/4), ST72324J(2/4/6), 
ST72324K(2/4/6), ST72324LS(2/4), ST72324BLS(2/4), ST72325AR(6/7/9), 
ST72325C(6/7/9), ST72325S(6/7/9), ST72325J(4/6/7/9), ST72325K(4/6), 
ST72325R(7/9), ST72361AR(4/6/7/9), ST72361J(4/6/7/9), ST72361K(4/6/7/9), 
ST72361R(4/6/7/9), ST72340K(2/4), ST72340S(2/4), ST72344K(2/4), 
ST72344S(2/4), ST72345C4

ST7 CAN ST72511R(6/7/9), ST72521AR(6/9), ST72521M9, ST72521R(6/9)

ST7 LCD ST72389B, ST72589B

ST7 MC ST72141

ST7 OP ST72171

ST7 USB ST7260E(1/2), ST7260K(1/2), ST72631, ST72632, ST72633, ST7263BD6, 
ST7263BH(2/6), ST7263BE(1/2/4/6), ST7263BK(1/2/2U1/4/6)

STM8 STM8A(F/H)5169, STM8A(F/H)5178, STM8A(F/H)5179, STM8A(F/H)5188, 
STM8A(F/H)5189, STM8A(F/H)5198, STM8A(F/H)5199, STM8A(F/H)519A, 
STM8A(F/H)51A8, STM8A(F/H)51A9, STM8A(F/H)51AA, STM8A(F/H)6146, 
STM8A(F/H)6148, STM8A(F/H)6166, STM8A(F/H)6168, STM8A(F/H)6169, 
STM8A(F/H)6176, STM8A(F/H)6178, STM8A(F/H)6179, STM8A(F/H)6186, 
STM8A(F/H)6188, STM8A(F/H)6189, STM8A(F/H)6198, STM8A(F/H)6199, 
STM8A(F/H)619A, STM8A(F/H)61A8, STM8A(F/H)61A9, STM8A(F/H)61AA
STM8L101F2(P/U), STM8L101F3(P/U), STM8L101G2, STM8L101G3, 
STM8L101K3
STM8S103F3, STM8S103K3, STM8S105C4, STM8S105C6, STM8S105K4, 
STM8S105K6, STM8S105S4, STM8S105S6, STM8S207MB, STM8S207RB, 
STM8S207CB, STM8S207R8, STM8S207C8, STM8S207S8, STM8S207R6, 
STM8S207K6, STM8S208MB, STM8S208RB, STM8S903K3
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3 Known problems/limitations

3.1 Known problems/limitations for STVD installer
● You must install STVD prior to connecting a debug instrument to the host PC's USB 

port, in order to have the necessary driver.

● The USB driver for the Raisonance RLink is not installed upon installation of STVD. 
After installing STVD, RLink users must install the RLink USB driver by selecting 
Start>ST7 Toolset>Setup>Install RLink driver.

3.2 Known problems/limitations for STVD interface
The include files provided upon installation of STVD are not the same as those required 
when using the ST7 Library or STM8 Library. ST7 and STM8 library users should refer to 
the appropriate ST7 or STM8 Library documentation for information about the correct 
include files to use.

Cosmic C toolset

In the Cosmic Linker for STM8 microcontrollers, the .const segment must be located in 
the first 64Kbyte segment. This is mandatory because the Cosmic toolset cannot link an 
interrupt handler that is not located in segment 1.

Metrowerks C toolset

● The automatic generation of the Linker PRM file can only be used when generating an 
executable in ELF/DWARF 2.0 format. For Hiware format, users must use a written 
PRM file.

● Using the -StatF= option with Hiware format may cause a failure during linking. The 
executable is not produced.

● When using the recommended ELF format and STVD include files, a link error L1818 
may be generated due to paginated registers. You can add the option -wmsgsi1818 
as a user-defined option. This option will convert the error to a warning message only.

3.3 Known problems/limitations for debug interface
● When the program is stopped on a breakpoint set on a function name, the displayed 

argument values may be false.

● When .hex or.s19 files are loaded outside of any workspace, an error message is 
displayed, but it is meaningless.

● Double type” variables are referred as “float type” variables.

● The const variable qualifier is not displayed.

● Only one instance of STVD can be running on your PC at any given time.

● Reduced user access rights to the database registry or to the STVD install directory 
can impede the normal use of STVD. A warning message occurs if a read/write access 
problem occurs.
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3.4 Known problems/limitations for STICE targets
● Data EEPROM can be written by the application, but the EOP status bit in Flash IAPSR 

register is not emulated (does not rise up after write).

● NEM breakpoints on data access are limited to the memory area range [0-0x7FFF], 
NEM breakpoints on opcode fetch are limited to addresses higher than 0x7FFF.

● Coverage and profiling functionality is limited to core running at up to 12 MHz.

● Data coverage and occurrence profiling mode is not reliable when there are 
simultaneous read and write accesses: some accesses can be missed, or fake 
accesses can be detected.

● Code occurrence and time profiling limitations:

– Whatever the time profiling mode, the profiler does not profile the first or the first 
two instructions after a breakpoint.

– It also does not profile correctly the last or the last two instructions before a 
breakpoint.

– If there is an interrupt, the number of occurrences of the interrupted instruction is 
incremented. As a result, the average time spent in a routine is incorrect if its first 
instruction is interrupted. However the total time is correct.

● Contrarily to what is said in the online help, the Subroutine mode (interrupt time 
excluded) is not available in this release. Only the Subroutine and Interrupt mode 
(interrupt time included) is available.

● Time profiling limitations in the Subroutine and Interrupt mode:

– The time spent in the return instruction of a function is sometimes missing in the 
cumulated time displayed at the calling instruction.

– The time for recursive functions is not correct.

– The longjmp C library routine should not be used otherwise the results will be 
erroneous.

– The results may be incorrect with the Raisonance compiler if it calls a library 
routine which uses the stack in a nonstandard way.

– For code written in assembly language, the subroutine modes work only if routines 
use the stack in a standard way. To be certain there is no problem, make sure that 
each routine is called by a call instruction and that it returns to its caller by a return 
instruction.

● USB communications may sometimes be lost in full speed mode (12 Mbit/s), 
depending on the frame length. It is recommended to use the STICE on a PC 
supporting USB high speed communications (480 Mbit/s).

3.5 Known problems/limitations for ICD-SWIM targets
● The red HALT status bar at the bottom right of the STVD window means that the 

microcontroller is either in low power mode (Halt, WFI or WFE), or is executing 
protected code. In these states, the SWIM debugger does not have any control over the 
microcontroller.
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3.6 Known problems/limitations for ST7-EMU3 targets
● When the emulated MCU is executing a Halt or Wait for Interrupt instruction and 

application execution is stopped using Debug>Stop Program or an external trigger, 
upon continuation, certain counters like timers and watchdog will have increased or 
decreased by several pulses.

● The Time Stamp in the Trace window includes Discarded events, including those used 
by the emulator at a break in execution (breakpoint) and when stepping through the 
code. The time stamps that result from stepping through a section of code will differ 
from those that result if the same code is run normally. The time stamps are not 
recalculated when filtering is used to remove events from the Trace display.

● When the microcontroller is in a Halt state, it is not possible to reset it using the LVD 
RESET command from STVD’s Hardware Simulation window.

● Writing to Flash program and EEPROM program non-volatile memory via the 
associated control registers are not emulated. The default memory mapping 
configuration for these areas is read only, however they can be changed to R/W (RAM) 
if necessary.

● Target MCUs, the Reset vector is not displayed in Trace Window.

● When using an I2C or DDC peripheral, use a pull-up resistor of 1.5 kOhms or less.

● The Performance Analysis has the following limitations:

– Performance Analysis does not work properly if the portion of code analyzed has 
entry/exit points not monitored by the Performance Analysis tool.

– Timestamp discontinuity can occur when the required number of passes on a 
code fragment is too large.

Note: The command Debug Instrument>Debugging discrepancies displays the differences 
between the emulation system and the target MCU.

ST7MDT10-EMU3

● The following limitations are not included in the Debugging discrepancies window:

– All ST7FLITE devices (except the ST7226x): When using PA4 and PA6 as input for 
VIL = 0.4V there is an IIL current of 200 µA.

– All ST7FLITE1B devices: The analog comparator is not emulated. As a result 
these registers have been mapped as non-existent registers (NER), and a break in 
execution will occur if they are accessed by the application. If the users application 
uses these registers, they can be mapped to read/write in the Memory Mapping 
window so that a break will not occur when they are accessed.

● When emulating the ST72F26xx family with the ST7MDT10-EMU3 emulator, the 
memory area from 0xd760 to 0xdedf is typically defined as non-existent memory 
(NEM). Do not change this designation, as the emulator cannot interpret instructions in 
this zone.

● AWU RC calibration is not supported because this RC is emulated by a fixed frequency 
from an oscillator.

● RC oscillator and the input capture are not connected for the auto-reload timer.
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3.7 Known problems/limitations for ST7-DVP3 targets
● When the emulated MCU is executing a Halt or Wait for Interrupt instruction and 

application execution is stopped using Debug>Stop Program or an external trigger, 
upon continuation, certain counters like timers and watchdog will have increased or 
decreased by several pulses.

● Upon wake up from a Halt or Wait for interrupt state, if STVD stops execution on a 
breakpoint that has been set on the first instruction of an interrupt routine, the position 
of the program counter (PC) in relation to the last instruction executed is incorrect (PC 
stops one address prior to the address of the break point). To avoid this, users should 
not set breakpoints on the first instruction of the wake up interrupt routine.

● The minimum frequency for DVP3 emulators is 2 MHz, instead of 500 KHz.

● When using an I2C or DDC peripheral, use a pull-up resistor of 1.5 kOhms or less.

● In the hardware event window if you change the event type the address of the hardware 
event is incremented automatically.

ST7MDT10-DVP3

● The following limitations are not included in the Debugging discrepancies window:

– All ST7FLITE devices (except the ST7226x): When using PA4 and PA6 as input for 
VIL = 0.4 V there is an IIL current of 200 µA.

– All ST7FLITE1B devices: The analog comparator is not emulated. As a result 
these registers have been mapped as non-existent registers (NER), and a break in 
execution will occur if they are accessed by the application. If the users application 
uses these registers, they can be mapped to read/write in the Memory Mapping 
window so that a break will not occur when they are accessed.

● AWU RC calibration is not supported because this RC is emulated by a fixed frequency 
from an oscillator.

● RC oscillator and the input capture are not connected for the auto-reload timer.

Note: The command Debug Instrument>Debugging discrepancies displays the emulation 
limitations that are specific to the target MCU.
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3.8 Known problems/limitations for ST7-ICD targets
● The following apply when in-circuit debugging of applications on XFlash devices 

without a debug module (ST72FLITE0/S and ST72F26x):

– Flash memory from FF12-FFDF is used for the debug monitor (ST7FLITE0/S).

– Stop Program is not possible (error and loss of communication with the target).

– Advanced Breakpoints are not possible (feature cannot be accessed in the GUI).

– Instruction Breakpoints in the Flash sector 0 are not possible (error message).

– Stepping in the Flash sector 0 is not possible (results in an error message).

● You must install STVD prior to connecting a debug instrument to the host PC's USB 
port, in order to have the necessary driver.

● Some changes made to the MCU memory mapping in STVD are not taken into account 
during in-circuit debugging as they are controlled by the device’s option byte.

● The Step Over command does not work properly when timer interrupt frequency is too 
high. As a workaround, select Debug Instrument>Stepping Mode and change the 
mode to Don’t Enter Interrupts When Stepping Into.

● The TRAP instruction generated by a software breakpoint can set off a hardware 
breakpoint when the hardware breakpoint points to an address in the stack. When this 
happens the application crashes. The program counter’s (PC) real position is not the 
same as the position reported in the Disassembly window. Before continuing, reset the 
position of the PC:

– by entering the desired position for the PC in the Program Counter field of the 
ST7 Register window, or

– by highlighting the position in the Disassembly window and clicking on Set PC.

Workaround: Do not set hardware breakpoints in the stack when using software 
breakpoints, or when the Stepping mode is set to Don’t Enter Interrupts When 
Stepping Into.

Note: The command Debug Instrument>Debugging discrepancies displays the emulation 
limitations that are specific to the target MCU.

3.9 Known problems/limitations for ST7-EMU2 (HDS2) targets
● When using an I2C or DDC peripheral, use a pull-up resistor of 1.5 KOhms or less.

● No time indication is recorded and displayed in the trace window.

● Clear Trace command does not work properly.

ST7263x-EMU2 emulator

● Timer A behaves incorrectly.
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ST7MDTU5-EMU2B emulator

ST72652 and ST72F652 are supported by this emulator, but with the following limitations 
due to problems/limitations with some versions of the target MCU:

● Normally ADC, I2C and PWM are not available for these sale types, but they are still 
present when ST72652 is selected in the MCU Configuration window.

● Options bytes are not user-configurable at present. Refer to the ST7MDTU5-EMU2B 
(HDS2) Emulator User Manual for details.

3.10 Known problems/limitations for ST7-DVP/DVP2 targets
● A complete host PC crash may occur if you power off the development kit board during 

an STVD session. In particular, if you change from Debug mode to Build mode, then 
power off your development kit board, and then attempt to re-enter Debug mode (with 
your development kit board powered off), a total host system crash will occur.

● The CPU frequency (FCPU) of the emulated device must be set in a range from 500 
KHz to 8 MHz even if Slow mode is selected.

The link between FCPU and CLOCK is: FCPU = (CLOCK / 2) / Slow mode (e.g. If you 
use a 5MHz external clock it is possible to select Slow mode factor 8, but not factor 16).

3.11 Known problems/limitations for simulators
Known problems or limitations on all microcontrollers: 

● When exporting graphed information from the Plotter window to VCD file, select an item 
with all its subitems, or all plotted items to ensure that no information is lost. Time 
information loss may occur when exporting selected subitems within an item.

Known problems or limitations on ST7 microcontrollers:

● The following is the list of peripherals that are supported during simulation:

● Known peripheral problems/limitations: there is a conflict between ports and 
peripherals for pin access. No arbitration is done by the Simulator. If you use a 
peripheral, do not use the pins which are connected to this peripheral as standard 
input/output pins.

Known problems or limitations on STM8 microcontrollers:

● The STM8 instruction simulator is not accurate in terms of number of cycles. The 
number of cycles given for an instruction is the minimum number of cycles found in the 
programming manual. It does not take into account possible slowdowns in the pipeline 
execution.

● STM8 peripherals are not supported. However, in addition to instruction set simulation, 
interrupts are supported through pseudo pins IRQ0 to IRQ29. 

• ADC

• Autoreload Timer (for ST7FLITEx)

• Beep
• EEPROM

• I2C

• I/O Ports
• Lite Timer (for ST7FLITEx)

• Main Clock Controller

• PWM Autoreload Timer

• Real Time Clock
• SCI

• SPI

• Timer
• Watchdog
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4 Information for major previous releases

4.1 Summary of changes in release 4.1.0

New features

New features in this release include:

● STICE: coverage/profiling on STM8A and STM8S microcontrollers, with core running 
up to 12MHz.

● ICD-SWIM: support of ST-Link board as SWIM dongle.

Improvements

Improvements in this release include:

● Up to 4 "memory" windows may be opened simultaneously.

● Management of global variables automatic relocation for Raisonance toolset.

● Added .bit section in Cosmic link script file.

● Main.asm and mapping.inc files automatic creation during creation of Assembler/Linker 
project.

● Enhanced performance of find in files function.

● SWIM communication enhancements on STICE (SWIM dongle).

● SWIM debugger: Flash and data EEPROM RASS protections are restored to user's 
state before running user's application.

● Stack location adjusted to datasheet on STM8A and STM8S microcontrollers.

● On simulator CPU frequency is now entered by the user. Default value is 16 MHz.

Corrections

Corrections in this release include:

● User defined option in ST Assembler/Linker project.

● Project was not rebuilt after suppression of project source file(s).

● Bugfix with +e directive of Cosmic assembler (Assembler/Listing/Generate an Errors 
Log File).

● STM8 Raisonance Builder: CODESTART directive address includes Vectors area.

● Fixed issue with RLink SWIM when the microcontroller in Halt mode.

● Fixed potential issue in identification procedure of a microcontroller in SWIM hotplug 
mode.

4.2 Summary of changes in release 4.0.1

New features

This release provides support for the STM8S207x and STM8S208x families of 
microcontrollers.
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Improvements

Improvements in this release include:

● Parallel port driver installation/de-installation is now subject to user’s agreement.

● With the Cosmic C compiler:

– Boolean variables are now properly initialized: the .bit section is automatically 
generated in the linker input file

– Debug information for function parameters is improved for STM8 microcontrollers.

● With the Raisonance toolset, the number of optimization levels is reduced to 4 for 
greater ease of use.

● STM8A AFREMAP options are managed on STICE.

Corrections

Corrections in this release include:

● When a source file is modified while in Debug mode, the debug session is now 
properly managed.

● STICE trace timestamp overflow event is properly managed.

● When a debug session is stopped, SWIM communication is switched off on the 
microcontroller side.

4.3 Summary of changes in release 4.0

New features

STVD release 4.0 provides support for the following additional microcontrollers:

Simulator

– STM8AF5168, STM8AF5169, STM8AF5178, STM8AF5179, STM8AF5188, 
STM8AF5189, STM8AF5198, STM8AF5199, STM8AF519A, STM8AF51A8, 
STM8AF51A9, STM8AF51AA

– STM8AF6166, STM8AF6168, STM8AF6169, STM8AF6176, STM8AF6178, 
STM8AF6179, STM8AF6186, STM8AF6188, STM8AF6189, STM8AF6198, 
STM8AF6199, STM8AF619A, STM8AF61A8, STM8AF61A9, STM8AF61AA

In-circuit debugging through SWIM

– STM8AF5168, STM8AF5169, STM8AF5178, STM8AF5179, STM8AF5188, 
STM8AF5189, STM8AF5198, STM8AF5199, STM8AF519A, STM8AF51A8, 
STM8AF51A9, STM8AF51AA,

– STM8AF6166, STM8AF6168, STM8AF6169, STM8AF6176, STM8AF6178, 
STM8AF6179, STM8AF6186, STM8AF6188, STM8AF6189, STM8AF6198, 
STM8AF6199, STM8AF619A, STM8AF61A8, STM8AF61A9, STM8AF61AA
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STICE

– STM8AF5168, STM8AF5169, STM8AF5178, STM8AF5179, STM8AF5188, 
STM8AF5189, STM8AF5198, STM8AF5199, STM8AF519A, STM8AF51A8, 
STM8AF51A9, STM8AF51AA,

– STM8AF6166, STM8AF6168, STM8AF6169, STM8AF6176, STM8AF6178, 
STM8AF6179, STM8AF6186, STM8AF6188, STM8AF6189, STM8AF6198, 
STM8AF6199, STM8AF619A, STM8AF61A8, STM8AF61A9, STM8AF61AA

STVD release 4.0 also provides support for:

● The Cosmic C toolset for STM8

● The Raisonance C toolset for STM8

● STICE advanced emulation system

You can access the full set of configuration features from the Project Settings interface.

Improvements

Improvements in this release include:

● The Cosmic C compiler setting for the memory model is now consistent with the startup 
file. For example, in an ST7 project, selecting the Long Stack memory model will 
trigger crtsx.st7 at startup.

● In the Cosmic Linker, for all toolsets, the Default button now sets correctly the default 
startup file according to the memory model. For example, in an STM8 project, if the 
current memory model is Long Stack, clicking on the Default button will set the startup 
file to crtsi.sm8, which is the default value for that model.

Corrections

This release includes a number of small corrections that occurred only in marginal 
configurations of use.

4.4 Summary of changes in release 3.5.0

New features

STVD7 release 3.5.0 provides support for the following additional microcontrollers:

Simulator

– ST7FOXK1, ST7FOXK2, ST7FOXF1, ST7FOXU0, ST7FLUS5, ST7FLU05, 
ST7FLU09, ST7FLI49K2T6, ST7FLI49K2B6

In-circuit debugging

– ST7FOXK1, ST7FOXK2, ST7FOXF1, ST7FLI49K2T6, ST7FLI49K2B6

STVD7 release 3.5.0 also provides support for the Raisonance C toolset. You can access 
the full set of configuration features from the Project Settings interface.
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Improvements

Improvements in this release include:

● The Find in Files feature now proposes the path of the previous search, except if the 
current project has changed, in which case the path of the current project is proposed.

● The list of microcontrollers in the MCU Selection dialog box is dependent on the 
toolset: only the microcontrollers supported by the selected toolset are listed.

● Simulator provides full support for all new features of Lite1B auto-reload timer:

– forcing of counter 1 and counter 2 overflow

– separate break for counter 1 and counter 2

– one pulse mode on PWM2 and PWM3

● For Lite49M auto-reload timer, Simulator supports distinct output compare interrupt and 
input capture interrupt.

● For Lite 49K auto-reload timer, Simulator supports the second break pin.

Corrections

With simulator, instructions performing a read access to a port data register with some of 
the port pins configured as inputs are now correctly executed.

This release also includes a number of small corrections that occurred only in marginal 
configurations of use.

4.5 Summary of changes in release 3.4.0

New features

STVD7 release 3.4.0 provides support for the following additional microcontrollers:

ST7MDT40-EMU3 emulators

– ST7FLITE54K4/S4,ST7FLITE55C4 

Simulator

– ST7FLITE54K4/S4, ST7FLITE55C4, ST7FLITE49M

In-circuit debugging

– ST7FLITE54K4/S4, ST7FLITE55C4, ST7FLITE49M 

Improvements

Improvements in this release include:

● A new option on the Edit/Debug tab allows you to select the behavior of the system 
before building a project or before starting a debug session. You can either request to 
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be prompted to save your files (Prompt before Saving Files option), or select to save 
files automatically (Automatic File Saving option).

● In the project settings window, the Linker tab/general category options now show the 
list of linked standard libraries.

● In the project settings window, STVD7 prompts you for confirmation when you create a 
section in the linker/input that has the same name as an existing section. Previously 
this operation was not allowed.

● When you change the selected MCU, you get a message warning you that some of the 
build options might be replaced by the default settings for that type of circuit.

● The menu option and window title Emulation Discrepancies has been renamed and is 
now called Debugging Discrepancies.

● The debugging discrepancies feature has been extended to the simulator. For some 
circuits, the Debugging Discrepancies window lists the limitations pertaining to the 
simulated circuit.

● Support for booleans with the Cosmic C compiler. There is however, a limitation 
because boolean variables are not properly initialized.

● In the simulator, you can generate interrupt requests from the I/O stimulation window. 
This is done by changing the value of the IRQx pseudo pin. This feature is useful for 
debugging code that manages non-simulated peripherals.

Corrections

Corrections in this release include the following major fixes:

● The update of the STM Parallel driver version 1.2 (a driver used by some third-party 
tools and installed with STVD7 prior to version 2.0) under Windows XP Service Pack 2, 
no longer causes a crash during installation. 

● Initial project settings are properly restored when Cancel is done after selecting Default 
settings.

● Link file modifications are automatically taken into account in the list of build 
dependencies.

● When opening a project, a warning message is displayed when a file that was part of 
the project no longer exists. This message is no longer displayed each time the project 
is opened.

● The following problems related to wrap executable projects have been corrected:

– The Export Makefile option is disabled, thus avoiding a system crash.

– The pathname for the executable file is now relative to the projected path, which 
makes it easier to transfer projects from one computer to another.

– When creating a wrap executable project, the interrupt vector file is no longer 
added.

When starting a debugging session, a message was displayed to indicate that the 
debugging information could not be found. This message is no longer displayed.

4.6 Summary of changes in release 3.3.4 (April 2007)

New features

STVD7 release 3.3.4 provides support for the following additional microcontrollers:
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ST7MDT10-EMU3 emulators

– ST7FLITEU0(2/5/9)

Simulator

– ST7FLITEU0(2/5/9), ST72324LS(2/4), ST72324BLS(2/4)

In-circuit debugging

– ST7FMC2S7, ST7FLITEUSICD (ST7FLITEUS 16-pin package specially designed 
for in-circuit debugging), ST7FLITEU0ICD (ST7FLITEU0 16-pin package specially 
designed for in-circuit debugging))

Improvements

In this release, STVD7 checks whether a build is required before starting a debug session.

Corrections

Corrections in this release include the following major fixes:

● In the main configuration window the Modify Area did not work properly in STVD7 
3.3.3. This regression compared with STVD7 3.3.2 is fixed in this release.

● The linker file is now included in the build dependencies list for non-automatic Cosmic 
projects.

4.7 Summary of changes in release 3.3.3 (December 2006)

New features

STVD7 release 3.3.3 provides support for the following additional microcontrollers:

ST7MDT20M-EMU3 emulators

– ST7321M(6/9)

ST7MDT40-EMU3 emulators (previously called ST7MIDI-EMU3)

– ST72340S(2/4), ST72344S(2/4), ST72345C4

ST7MDT50-EMU3 emulators

– ST7MC2S7

ST7MDT20-DVP3 emulators

– ST72321M(6/9), ST7FLITEUS(2/5)

Simulator

– ST72321M(6/9), ST72321BM(6/9), ST72325C(6/7/9), ST72325S(4/6), 
ST72340S(2/4), ST72344S(2/4), ST72345C4
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In-circuit debugging 

– ST7340S(2/4), ST72344S(2/4), ST72345C4

Improvements

Improvements in this release include:

● A template for the main source file (main.c) is provided when you create a new 
workspace and project.

● For Cosmic C compiler users, an additional column in the Linker Input table allows you 
to enter options for custom linker sections.

● For Cosmic C compiler users, the Linker Startup File selection list now offers the option 
None. When selected, the default startup routine is not used. You must create your 
own routine.

● Changes to vector file and microcontroller selection in Project Settings are now applied 
to all project configurations.

Corrections

Corrections in this release include the following major fixes:

● For Cosmic C compiler users, when the +split option is checked in the C Compiler 
Optimizations list in the Project Settings window, it is correctly added to the command 
line displayed at the bottom of the window.

● For Cosmic C compiler users, checking the verbose option (-v) in the C Compiler 
Listings options applies the option to listings and to optimizations, thus avoiding 
inconsistency in settings that could occur previously.

● Under certain conditions, icons disappeared from menus and menu bars in the main 
window. This problem is corrected.

● The vector file template (vector.c) is now generated only when the project is created. 
Its contents are no longer impacted by changes in the project settings.

4.8 Summary of changes in release 3.3.2

New features

● A check box, Show selected target notification at start of debug has been added to 
the Debug Instrument Settings (Debug Instrument>Target Settings). Checking this 
options resets the check box in the Target Selection pop-up, so that the notification is 
displayed at the start of the debug session.

● The following register window name changes have been implemented:

– ST7 Registers renamed to Core Registers

– ST7 Peripheral Registers renamed to Peripheral Registers

Plus support for the following microcontrollers:

ST7MDT10-EMU3 emulators

– ST7LITEUS (STVD7 3.3.2 with Patch 2)
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ST7MDT20J-EMU3 emulators

– ST72321BK6, ST7232AJ(1/2)

– ST7232xBLx6 (STVD7 3.3.2 with Patch 2)

ST7MDT20M-EMU3 emulators

– ST72321B(R6/R7/R9/AR6/AR7/AR9)

ST7MDTU3-EMU3 emulators

– ST7260(E1/E2/K1/K2), ST7263B(D6/E1/E4), ST7263BK2U1 (QFN40 package)

ST7MDT20-DVP3 emulators

– ST72321B(K6/R6/R7/R9/AR6/AR7/AR9), ST7232AJ(1/2)

In-circuit debugging (EMU3, DVP3 and RLink)

– ST7FLITE1(0/5/9), STFLITE0(2/5/9), ST7FLITES(2/5), ST72260G1, 
ST72262(G1/G2), ST72264(G1/G2), ST72F321B(J6/J7/J9/R6/R7/R9/ 
AR6/AR7/AR9)

– ST7FLITEUS, ST72F34xZ (STVD7 3.3.2 with Patch 2)

Simulator

– ST72321B(J7/J9/K6/R6/R7/R9/AR6/AR7/AR9), ST72324B(J6/K6), 
ST7232AJ(1/2), ST7260(E1/E2/K1/K2), ST7263B(D6/E1/E2/E4/E6/H2/ 
H6/K2U1/K6)

Corrections

Corrections in this release include the following major fixes:

● Corrects errors that occurred in the Plotter window when importing VCD files 
(File>Import...) and adding new items to a plot (Project>Add New Items...). In 
previous versions using these features resulted in an “Parser not found” error.

● Values for selected variables are correctly displayed in the Local Variables window. 
Corrects problem that appeared in STVD7 releases 3.3.0/3.3.1.

● Corrects false warning message that sometimes occurred when saving a workspace or 
entering a debug session after initial creation of a workspace.

Correction implemented with Patch 2:

● Corrects an error that occurred when in-circuit debugging ST7FLITE1x 
microcontrollers.
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4.9 Release 3.3.0/3.3.1 (January/February 2006)

New features

● Plotter now includes improved navigation and display controls, configurable signals, 
multiple configurable position markers, multiple configurable display tabs, item 
selection for printing and import/export of plotted data in VCD format.

● The Linker tabs of the Project Settings interface now allow creation of user defined 
memory segments and customization of the assignment of code sections to memory 
segments.

● Support of Raisonance’s RLink for both debugging and programming. After installing 
STVD7, RLink users must install the RLink USB driver. To do this, before launching 
STVD7, select Start>ST7 Toolset>Setup>Install RLink driver.

● Modification to display LEDs in the MCU Selection window. GREEN = MCU 
supported, YELLOW = Supported in Beta and GRAY = Not supported

● ST7MDT10-EMU3 emulator support of ST7L15F1, ST7L19F1, ST7L34, ST7L38

● ST7MDT10-DVP3 emulator support of ST7L15F1, ST7L19F1, ST7L34, ST7L38

● In-Circuit Debugging (EMU3, DVP3 and RLink) support of ST7L15F1, ST7L19F1, 
ST7L34, ST7L38

● Simulator support of ST7232AK(1/2), ST72325AR6

Corrections

● Find feature in the Editor windows modified so that search loops after reaching the top 
or bottom of the document. In preceding versions, the search stopped at the end of the 
document and no “end of the file” message was displayed.

● Corrects possible programming error sometimes occurring during in-circuit debugging 
of HDFlash MCU if code section crossed over boundary between two HDFlash sectors.

4.10 Release 3.2.1 (October 2005)

New features

● ST7-EMU3 improvements include: ST7MDT10-EMU3 support of ST7LIT10BF(0/1), 
ST7LIT15BF(0/1), ST7LIT19BF(0/1), ST7LIT10BY(0/1), ST7LIT15BY(0/1), 
ST7LIT19BY(0/1), ST7MDT20J-EMU3 support of ST72325C(4/6), ST7MDT50-EMU3 
support of ST7MC1K6, ST7MIDI-EMU3 support of ST72340J(2/4), ST72340K(2/4), 
ST72344J(2/4), ST72344K(2/4), ST72345N4.

● ST7-DVP3 improvements include: ST7MDT10-DVP3 support of ST7LIT10BF(0/1), 
ST7LIT15BF(0/1), ST7LIT19BF(0/1), ST7LIT10BY(0/1), ST7LIT15BY(0/1), 
ST7LIT19BY(0/1), ST7MDT20-DVP3 support of ST72325C(4/6), ST7MDT25-DVP3 
support of ST72361AR(4/6/7/9), ST72361J(4/6/7/9), ST72361K(4/6/7/9), 
ST72361R(4/6/7/9), ST72561AR(4/6/7/9), ST72561J(4/7), ST72561K(4/7), 
ST72561R(4/7)

● In-Circuit Debugging (EMU3 and DVP3) improvements include support of 
ST7FLIT10BF(0/1), ST7FLIT15BF(0/1), ST7FLIT19BF(0/1), ST7FLIT10BY(0/1), 
ST7FLIT15BY(0/1), ST7FLIT19BY(0/1), ST72F325AR(6/7/9), ST72F325J(7/9), 
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ST72F325R(6/7/9), ST72F325C(4/6), ST72F340J(2/4), ST72F340K(2/4), 
ST72F344J(2/4), ST72F344K(2/4), ST72F345N4

● Simulator improvements include support of ST7LIT10BF(0/1), ST7LIT15BF(0/1), 
ST7LIT19BF(0/1), ST7LIT10BY(0/1), ST7LIT15BY(0/1), ST7LIT19BY(0/1), 
ST72325AR(6/7/9), ST72325J(4/6/7/9), ST72325K(4/6), ST72325R(7/9), 
ST72340J(2/4), ST72340K(2/4), ST72344J(2/4), ST72344K(2/4), ST72345N4, 
ST72361AR(4/6/7/9), ST72361J(4/6/7/9), ST72361K(4/6/7/9), ST72361R(4/6/7/9)

4.11 Release 3.2.0 (December 2004)

New features

● New Editor features including folding of source code, brace matching, highlighting and 
auto completion of language specific key words, and function prototype tips for 
Assembly source files.

● Workspace now allows creation of subfolders within folders in the Workspace 
window.

● Improved display in Disassembly window.

● Simulator improvements include: plotter outputs plot information in text format to VCD 
file, support of ST7LITE3(0/5/9), ST7L(05/09/35/39)

● ST7-EMU3 improvements include: support for ST7LITE3(0/5/9), ST7L(05/09/35/39), 
ST72325, MSCI Tools window displays the memory space dedicated to the ST7 Mass 
Storage Communication Interface and its registers for ST7267 (ST7MDTU7-EMU3).

● ST7-DVP3 supports ST7LITE3(0/5/9), ST7L(05/09/35/39) and ST72325

● In-Circuit Debugging (EMU3 and DVP3) improvements include: support of 
ST72F325J(4/6), ST72F325K(4/6), ST7267, ST7FDALI, ST7FLITE3(0/5/9), 
ST7FL3(5/9), ST7FMC1K(2/4), ST7FMC2S(4/6), ST72F325J(4/6), ST72F325K(4/6), 
MSCI Tools window for ST7267 (with EMU3 and DVP3)

Corrections

● The Block Selection tool allows cut, copy or delete of selections.

● Improved project file format allows automatic conversion of project files and generation 
of a backup file (*.bak).

● Library file path can now be added from the Directories tab of the Tool Options 
window (Tools>Options).

● Fixes problems related to use of macros in the build interface.

● Corrects crashes that occurred when debugging some applications in projects that had 
been created by ‘wrapping an existing executable file’.

● F4 is no longer used to navigate in bookmarks.

● For a register stored at 0x00, viewing in the Watch window no longer returns an 
unknown address error.
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4.12 Release 3.1.0/3.1.1 (December 2004)
● Support for In-Circuit Debugging (ICD) with ST7-DVP3 Emulators (Rel. 3.1.1).

● Support for ST7MDT25-DVP3 Emulator for ST72561 (Rel. 3.1.1).

● Support for ST7MDTU3-EMU3 Emulator for the ST72F63.

● Generate Support File allows automatic collection of error logs.

● Input Stimulator allows definition of periodic input signals (View>I/O Stimulation).

● Optimizes builder performance when assessing dependencies for large projects or with 
server-based compiler and a floating license.

● ST7-DVP3 improvements include: correction of errors occurring with fill memory on 
Special Function Registers (SFRs), allowing writing to EEPROM by typing the values in 
the Memory window, I2C registers no longer mapped as “Non-Existent Registers.”

● ST7-EMU2 improvements include: resolution of crashes occurring on some machines 
after launching a hardware test while debugging an application, then ending the debug 
session.

● ST7-ICD improvements include saving of trace configuration with the workspace and 
restored at Start Debug.

4.13 Release 3.0.1 (October 2004)
● EEPROM now simulated but with discrepancy in write time compared to MCU.

● Conversion feature for workspaces (.wsp) created by STVD7 prior to version 3.0.

● Highlighting of debug instruments that support the selected microcontroller.

● Resolves installation problems occurring with some configurations of Windows XP.

● Resolves option transfer problems occurring when the user changed the MCU 
selection in the project settings on a non-active build configuration.

● ST7 Assembler Linker, -sym option is added to the assembler command line by 
default.

4.14 Release 3.0 (April 2004)
● User Interface improvements include: Project Settings window for customizing the 

building of the application when using ST7 Assembler-Linker, Cosmic C or Metrowerks 
C toolsets, MCU selection integrated in the Project Settings interface, single installation 
of STVD7 supports the full range of debug configurations and hardware (Simulator, 
ICD, DVP3, EMU3 and EMU2), include files in C and Assembler that define and declare 
the peripheral registers for each ST7, programming interface based on STVP7 
supporting socket, in situ and in-circuit programming modes and hardware, two 
stepping modes that allow choice of whether or not to enter interrupts that may occur 
during stepping (Debug Instrument>Stepping Modes).

● ST7-Simulator improvements include: graphic interface to control sending of stimulus 
signals to the input pins of the simulated target microcontroller, plotter interface to 
graph the evolution of variables, registers and signals.

● DMA, IT and Stack memory access events are now included in the pull down list of 
configurable memory events in the Advanced Breakpoints window for ST7-EMU3.
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5 Revision history

         

Table 1. Document revision history

Date Revision Changes

23-Nov-2006 1 Initial release for STVD7 3.3.3.

20-Apr-2007 2 Release for STVD7 3.3.4.

20-Aug-2007 3 Release for STVD7 3.4.0.

6-Dec-2007 4 Release for STVD7 3.5.0.

11-Dec-2007 5 Update for STVD7 3.5.0.

06-Mar-2008 6 Update for STVD 4.0.

13-May-2008 7 Update for STVD 4.0.1.

9-Jun-2008 8 Additional updates for STVD 4.0.1.

27-Nov-2008 9 Update for STVD 4.1.0.

11-Dec-2008 10
Additional updates for STVD 4.1.0: updated Section 3.4: Known 
problems/limitations for STICE targets, added Section 3.5: Known 
problems/limitations for ICD-SWIM targets.

26-Feb-2009 11

Additional updates for STVD 4.1.1: added new MCUs in STICE 
advanced emulation system on page 7 and STM8-ICD-SWIM on 
page 9 and STM8 Simulators on page 10 and updated Section 3.4: 
Known problems/limitations for STICE targets.
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